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Introduction
Welcome to the SOFv Photoshop workshop! The 
workshop will consist of two parts: part A and 
part B. First I will elaborate on InDesign, and then 
I go into detail on the two parts.

About Photoshop
Photoshop is an Adobe program, meaning it is 
from the same authors as the famous InDesign 
and Illustrator. These are the three main pro-
grams that you will use when creating visual 
media. They are rather similar; they even use the 
same lay-out. Fun fact: on most university pc’s, 
they come pre-installed. Buying it yourself is 
actually quite an investment. 
Each of the three programs is capable of doing 
very simple tasks, such as moving pictures, 
making textboxes and drawing lines. However, if 
you want to get more in-depth, you will need to 
pick one of the three. Below I will elaborate a bit 
on when you should pick Photoshop, and when 
you should consider using InDesign or Illustrator.

When do you use InDesign?
InDesign is by far the most useful program when 
it comes to making consistent lay-outs and when 
you do quite some text-heavy work. Think of 
(year-)books, forms, newsletters, etc. If you want 
a lot of pages with roughly the same lay-out, 
only different contents: InDesign is your best 
friend.

When do you use illustrator?
Illustrator is actually the program you will proba-
bly need the least. This is where you make ‘dra-
wings’; think of logo’s or your own fonts. Every-
thing that has to do with vectors is edited most 
effectively in illustrator. Do not worry if you have 
no clue what those are.

When do you use Photoshop?
Well then, here we are. Why would you ever 
need Photoshop? Photoshop is the best for ma-
king heavy graphical edits, especially to existing 
photos. Therefore, this piece of software has the 
biggest range of effects, filters and graphical 
editing tools. When I was in primary school, my 
parents referred to it as “Paint for grown-ups”, 
which is actually pretty accurate. 

Part A
Part A
Part A of the workshop is for those totally new 
to InDesign. You will learn, amongst others, the 
following:
- Finding your way in Photoshop
- Making mistakes
- The basic tools
- Layers
- Colours
- Shapes
- Fun tools

Part B
The second part of the workshop is, as you pro-
bably guessed, for those with a bit more expe-
rience in Photoshop. This part will discuss a little 
more advanced topics, such as:
- More on layers
- Filters
- More on text
- More on brushes

In part B we will be covering less topics, but they 
will be much more in-depth. This part will also 
contain less instructions, so that you can already 
apply it to your own projects.

During the workshop itself I will be walking 
around and answering questions. Don’t hesitate 
to ask any questions, I thoroughly enjoy hel-
ping out and you will be able to move on faster. 
Sounds like a solid deal.

I made this ‘booklet’ especially for this workshop; 
if you find any unclarities or mistakes, let me 
know. I will submit the edited version later so 
you can have a look at it yourself all year, e.g. for 
reference. 

I hope you will be learning a lot!

Best of luck,

Jorrit

Finding your way in Photoshop
Before we start, it would be rather useful to know where you can find the various options. In this 
section, I will do my best to explain as clearly as possible what most buttons do, or where you should 
look if you want to do a similar edit. Open up Photoshop, and create a file of the size of an A3.

Above you can see what my screen looks like, with some drawn lines that I will explain in a moment. 
Before I continue with my explanation, do the following: go at the top of your screen to “Window 
-> Workspace -> Reset Essentials”. If you are not on a computer at the RU, also check whether you 
have the “Creative Cloud” (CC) version, instead of for example CS5 or something similar, that may 
also cause some differences.

Red
On the far left in red you see the most important buttons; these are your tools. These all have an 
icon, name, and a “shortcut” / hotkey. The move tool, the top one, can be selected by clicking on it 
or pressing “V”. It allows you to drag things around and adjust their size, and much more. You will 
use this most often.

In addition to the move tool, you will be using the selection tool, the brush tool, the text tool, and 
the shape tool a lot during the rest of the workshop. If you can use these tools well, you can actually 
already make beautiful and professional things. The rest of the tools can make your life a bit easi-
er, but in the first part of this workshop I mainly discuss those tools. I do recommend that after the 
workshop, once you have mastered the basics, you look at what exactly you can do with the other 
tools. Then if you ever have something more specific in mind, you might be able to get it done with 
one of those.

With the selection tool you indicate to Photoshop which part of your image you want to edit, and 
which part not. By the way, you can perform the usual cut, copy and paste operations with a selec-
tion. You will probably need that later on.
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The brush tool is pretty self-explanatory. With this you can paint, but you can also do some cooler 
edits if you have the right settings.

The text tool does exactly what its name suggests: you can use it to put text on your image.
Finally, we have the shape tool: with this you can draw simple shapes such as rectangles and circles 
on your image.

Yellow
The yellow rectangle indicates your worksheet. On this you can see the A3 that you have created, 
and above and below some “rulers”. You can base your guidelines on this later in the workshop. At 
the top you have some more tabs: if you have multiple projects open, you can always switch to them 
by simply clicking on them. The worksheet doesn’t look that exciting yet, but that will soon change.

Green
On the far right you also have some menus, outlined in green for me. At the top you see your colour 
palette. Below that some buttons with layer adjustments, and below that you see your layers. In fact, 
the latter menu is so useful that I have also kept a separate piece for the workshop. What is useful to 
know is how layers work exactly. See this cute picture that I just made. On the left you see the layers, 
on the right you see the result. Imagine that you are looking from above, so that you see layer 1 first, 
and then layer 5 last. Because layer 3 is made in such a way that it “hides” itself under layers 1 and 2, 
you will not see it in the result. In addition, layer 5 covers the entire range, while you only see a small 
part of it: that is because the rest is already covering it. You always see the top layer first, and the 
bottom layer last.

Blue
As in any other program you have at the top of this menu. Everything else speaks for itself, but it is 
important not to forget that this also still exists.

Orange
Finally, we have this part of your screen. This displays all kinds of properties and settings of the 
object you are working on. If you have selected the move tool, this bar will look like mine. However, 
when you do text edits, for example, it will be filled with all kinds of useful buttons for text edits, and 
so on. I will not go into it any more, it will show itself. I hope. Please ask otherwise!

Making mistakes
Before you get started, it is useful to know the following: the undo button in Photoshop is not as 
intuitive as you would hope.

If you made a mistake, you would tap CTRL + Z in other programs until you are back to where you 
were. However, you don’t get away that easily in Photoshop. You can only press CTRL + Z once; if 
you do it a second time you will see that your edit is back.
If you want to correct multiple errors, use CTRL + ALT + Z. You can then (default) go back a maxi-
mum of 20 steps. Just so you know!

What’s also good to know: every action you perform counts towards those 20 steps. If you draw 50 
very small dots, you can therefore only remove 20. So be careful!

Basic tools
Another thing about the tools that will come in handy: most tools share a place in the toolbar with 
similar tools. There are various selection tools, and the brush has also brought its friends. We will 
discuss those in a second. If you right-click on a tool, you will see which other, similar tools you can 
choose from. Then click on the tool you want to use.
 
Move
First, at the top of your screen (which was just “orange”), click “Show transformation tools”. This 
makes it easier to see which object you are moving and how big the object is. It also makes it easier 
to make the object bigger and smaller; I don’t really see any reason to leave it off.

With the move tool you can make objects move over your canvas and make them bigger. If you 
press SHIFT while applying the move tool (drag, resize, rotate), Photoshop will lend a hand. For 
example, when dragging you will only be able to make angles of multiples 45 degrees from your 
original location. The object’s size ratios will remain the same when resizing, and conventional angles 
will also be used when rotating (e.g. multiples of 30 degrees). I highly recommend becoming good 
friends with your SHIFT key.

The workshop folder contains some pictures that I picked out in a childish mood. Just grab the folder 
for a while and drag the minion onto your work surface. Then adjust the size of the minion until you 
are happy with it. When you’re done, hit this button:

If you don’t, Photoshop 
thinks you’re still using 
the move tool on the 
image. Then you can’t 
use all your other cool 
buttons in the mean-
time, that’s a shame.
For me it now looks like 
on the right, not bad, 
huh?

Do your future self a favour, by clicking “Rasterize layer”, as indi-
cated. You can do so by clicking with your right mouse button on 
the layer with the minion, and clicking “Rasterize layer”. What does 
exactly does, I will explain later.
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Selection
If you only want to do an interesting edit on a specific part of your image, the selection tool will 
come in handy. For example, you can choose to delete your selection, which is very useful in the case 
of removing backgrounds. In fact, a selection is the prelude to your cool edit, so you better  get the 
hang of it. What can help with this are the following two clever tricks: if you press SHIFT while mak-
ing a new selection, you can add your new selection to your old one (If you already had one). If you 
press ALT, you will actually see that the new selection is subtracted from your old one.

In addition, some other cool shortcuts that are too handy not to mention:
- CTRL + D: deselect all
- CTRL + A: select all
- CTRL + SHIFT + I: invert your selection (everything that is not selected is selected and vice versa)

Just give it a try. Choose the box selection tool (the 2nd from the top should be) and select the 
minion. There is now such a cheerful striped border around the minion. That means that everything 
in the striped border is selected. However, we want to keep the minion, so we’re going to flip our 
selection; everything but the minion must go (that I would say that someday ...).
So if you press the just learned CTRL + SHIFT + I, you will see the selection invert. This is further con-
firmed by the fact that the edge of the canvas now also has such a line. 

If you now hit the delete button you will see that the result is already quite decent. However, we 
want to cut out our annoying yellow friend more precisely. 
Fortunately, there are some other shapes and sizes selection tools besides the box selection tool. For 
example, you have the lasso tool. This itself also comes in three shapes, the normal, the polygonal 
and the magnetic lasso tool. 

With the normal one, you have to draw the selection yourself. 

With the polygonal you make it a bit easier for yourself by only clicking on the corners of the selec-
tion you want. This way your selection becomes a polygon. 

Finally, we have the smartest of the “brothers lasso tool”: the magnetic lasso tool. This uses artificial 
intelligence to fold itself around objects. Draw around the minion like the normal lasso tool, but 
preferably a bit wider, and you will see that the selection folds around your object quite perfectly. 
Useful. Don’t forget to double click when you are done with your selection.

On the next page, I have just applied all three lasso tools to the minion. Give it a try too, so you can 
get a feel for how it works.

As you can see, the magnetic lasso tool makes the most accurate selection with little effort. However, 
he still made a few careless mistakes: it excluded a piece of shoe and banana from me.

Then we have another (rather well-known) copy: the magic wand. With the help of this so-called 
magic wand you can make a selection in 1 click, based on the same colours in your image. Extreme-
ly effective on solid colors. If the colours are a bit further apart and the magic wand does not grab 
everything in one go, you can increase the ‘tolerance’ in the top bar. This is a percentage of how 
many identical colours are included in the selection.

Just pop your tolerance to 40 and click in the air. 
You will see that the selection looks something 
like this. What is a bit unfortunate, is that the 
banana is already seen as a “background” by our 
smart tool. In this case, the magic wand is a bit 
clumsy, but often this tool will provide the solu-
tion to your problem. So don’t forget about it! 

The wand also has a clever little brother, who 
also deserves some attention. The “quick se-
lection tool” (located together with the magic 
wand) is a special form of magic wand. Instead 
of clicking on colours and making his own 
selection, you draw roughly over the area that 
you want to select. Photoshop then calculates 
exactly which pixels do and do not belong there, 
again by means of equal colors.
With the help of the SHIFT and ALT keys to 
include and exclude pieces, this can quickly 
lead to a nice result, without having to think 
too much about it. On the right you can see the 
selection that I have put together in 30 seconds:

Make sure that even the piece under the arm 
on the left is also selected! By the way, you can 
tackle this problem from two sides: you can se-
lect the minion itself, or the area around it and 
then flip your selection. Both excellent solutions.

Then you can do whatever you want with your selection. You can throw it away completely, draw 
over it, ..... You can apply everything Photoshop has to offer to a selection. After all, if you don’t make 
a selection, you adjust the entire layer.
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As you have seen, there are many types of selection tools, and they are all good at something differ-
ent. It really pays off to be familiar with all selection tools, because each tool has its good and bad 
sides. For example, the magic wand is one of my favourites, but it did not come into its own in this 
example. Even the box selection tool (by far the least specific) has its advantages. So look carefully 
for each problem which one you need exactly!

Brush
The tool that I will now highlight is perhaps the 
one that appeals the most to the imagination of 
all: it is the brush that you have used to slide all 
those ugly paint pictures together. Just select it 
on the left (8th from the top, or shortcut “B”).

As you may remember from your elementary 
school days, you can get started with colouring 
just by clicking while sitting on your canvas. 
However, it will be a bit small (by default). You 
can adjust the brush settings by clicking on the 
ball in the top left (that is currently the shape 
you are painting with). To the right of here, you 
see what settings I have taken for my brush. 

To explain: size is the diameter in pixels, and 
hardness is whether you want the brush to have 
a nice soft finish or not, and how much. Just 
tweak the settings for a while to your liking.

If you need colours; at the top right you can 
choose some colours. I will go into this in much 
more detail in a later heading, so I will not 
explain in detail how and what all. If it does not 
show itself, you have to do it with black for a 
while.

A nice trick: if you want a straight line between 
a point A and a point B, you can click point A, 
hold down SHIFT (there it is again) and then 
click point B.

You can also scroll through the brush settings 
(at the bottom) and choose all kinds of special 
brushes. Just make a piece of art: I did that too. 
Well, at least my mother thinks it is beautiful. 

Eraser
The eraser (eraser) is a kind of “deleting brush”. 
All pixels in the path of the eraser are removed. 
At least, all pixels on that layer will be removed. 
The eraser has exactly the same settings as the 
brush. Because I think it’s a bit of a shame to 
just throw away my millions of work, I’m only 
going to do it temporarily. I scratch a little, then 
press CTRL + ALT + Z just as many times to get 
back to my original.

Text
You can also create text in Photoshop. You can probably guess what to do with that: the big T that is 
reasonably at the bottom. That “T” is also the shortcut for this tool.

You can pump text into your image in two ways: you can just click on your image and start typing, 
or you can draw a text box that will keep the text in it at all times. The latter is useful if you don’t 
want to exceed the border, but I use the former most often, so I’m going to show it now. If you want 
to draw a text box instead; click on your canvas to define the top left corner of your text box, hold 
down your mouse, then drag to the bottom right to indicate the size of your box.

When you click on your canvas with your text tool, you will see that you can start typing. You can 
also see the bar at the top change to this:

On the left you can adjust your font; the type (regular, bold, italic, ....) and the size. Try the other 
settings for a while to see what it does. For example, you can also determine your text colour above 
it. Note: all these settings only apply to the piece of text you have 
selected.

When you’re done, just hit that nice check button, which we used 
before. Some unsolicited design advice: a font can give your de-
sign a huge aesthetic boost or destroy it completely. Choose your 
font carefully! The Comic Sans font exudes exactly that sadness 
that the rest of the drawing does; a perfect match.

Here you can see my result is also here. Who would have thought 
you would be putting something so childish together tonight. 

Layers
What you may have noticed is that the menu at the bottom right, 
that of the layers, has some elements added. For my artistic mas-
terpiece, the layers look like on the right.

Each bar in this menu symbolizes a layer in your document. For 
example, I have four: two with text, one with my drawing and one 
for the white background. As you hopefully remember from the 
intro, the layers work from top to bottom: if I placed the image 
hierarchically above the text, you wouldn’t be able to see it.
Using layers is very convenient. The thing is, if I want to move the 
minion now, it will be a lot more difficult. Since the entire drawing 
is on the same layer, I can no longer grasp its individual elements. 
The tree is literally attached to the grass, and the stones to the 
water. If you drag the image you will see that you can no longer 
drag the water separately with respect to the stones, while that 
actually sounds attractive. This way you can update your compo-
sition a bit afterwards, and your adjustments are a lot less dev-
astating. If you work on the same layer, you throw away all pixels 
that you paint over.

I highly recommend using layers in your project so that you can 
always easily create alternative versions. You can even give the 
layers meaningful names to make things easier. Just double-click 
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on the layer with your work and give it a recognizable name. You can easily create a new layer by 
clicking the button at the bottom next to the trash can.

You can also organize things even more by creating folders. All ele-
ments in a folder then form a “group”. At the bottom you can click on 
the folder icon to create such a folder. Then drag the layer on the bar 
that belongs to the folder to add it to it. You can also select all the lay-
ers you want in it (click on them all individually while pressing CTRL), 
and then press CTRL + G: all your elements will immediately end up in 
the group. Useful!

You can then also give the group a meaningful name. As you can see, 
this makes the menu a lot clearer. You can also collapse the folders by clicking the arrow to the left 
of the folder icon. Good document structure and labels will pay off, especially in the long term.

This is just the beginning. This way you can also provide each layer with a range of cool effects. 
Right-click again on your layer and select the top option “blending options”. Here you can see all 
the effects you can choose from on the left. For example, apply a “drop shadow” to your design. This 
one has a lot of properties: play around with it until you get something that you are proud of. I have 
chosen the following settings:

Make sure that the ‘preview’ option is also turned on, on the right side of your layer style menu. Oth-
erwise you will not be able to see what you are doing. Decorate your layers with the effects: take a 
look at what they all do, so that you know what your options are later. When you are done, you can 
click OK. You will see that your effects are also displayed in the bottom right of the layers menu.
If you want another layer to have the exact same effects you have now chosen for a particular layer, 
you can right-click on that layer, select “copy layer style” at the bottom, and then “paste layer style” 
on the other layer. to do. Done!

Just browse through all the options you get when you right-click on a layer. Did you know you could 
label layers and groups with colours? In the menu you also found that you could rasterize. I’ll keep 
you in suspense for a moment about what that might mean.

If you click on the eye icon, you can choose whether to make that specific layer or effect (tempo-

rarily) invisible, for whatever reason. Pretty handy. This also works for groups! You can turn off your 
entire group in one fell swoop.

In addition, each layer also has its own transparency and filling. These are two very similar things, 
but there is a difference: the transparency applies to the entire layer including effects. This way your 
shadow will fade with the content of the layer. Adjusting the “Fill” will only make the content of your 
layer more transparent, but the effects will remain the same. For example, if you now pop the fill to 
0, you will see that the shadow of the text remains. This already works on groups too! Note that the 
effects on your individual layers are not “assigned” to your group, so the fill works differently. If you 
want to provide a group with effects, that is of course also possible.

That was the basis of layers. In the B section you will find a whole section dedicated to all kinds of 
other cool features of layers, but you don’t need to know that to already put some really neat things 
together.

Kleuren
Here we are. Colours. On the far left you see two squares; black and white. The top col-
our may already have changed, depending on whether you have just chosen colours. 
In that case, just press the button you see in the top left corner for a moment: it will 
switch the back to black and white.

The top colour is your primary colour: you can also paint with it, for example. The 
bottom one is your secondary colour: you keep it on hand for e.g. your accents, or for 
whatever reason. You can swap the colours by clicking the arrow at the top right, or by clicking “X” 
on your keyboard. Pretty useful.

If you double-click on a colour, a very extensive colour selection menu will appear. This is your 
colour picker. Here you can choose your colour in the square in the middle: from top to bottom it 
transitions from white to black, and from left to right in white to the colour that you have selected 
from your colour spectrum to the right of the square.

You can also manually enter RGB values or enter 
a colour code immediately. You can also sample 
your colour by going to your canvas and click-
ing on a pixel that has the colour you want. The 
menu will then immediately jump to the colour 
you want. For instance, choose the yellow of the 
minion as the colour.

All this can also be done at the top right, in the 
colour menu. Occasionally there are also some 
suggestions from Photoshop: an exclamation 
mark means that print-technically it may not be 
the best colour and that it is better to use the 
colour that Photoshop offers you in addition, 
and a box means that it is not an ideal colour is 
for a website. Do not worry too much about it, 
but then you know what it does. 

If you click on the tab “swatches” at the top, you will see a list of colours. At the top you will find the 
most recent colours you have used, and below that a whole series of colours that Photoshop recom-
mends you. This is how it starts with the primary and secondary colours, then a series of shades of 
grey, eventually some pastel colours etc. etc. You can add your favourite colours to this list by click-
ing on the ‘new’ icon at the bottom while you have that colour as the primary colour selected.
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You can also click on those 4 horizontal stripes at the top right and 
add a whole colour library. Here you will find, for example, a whole 
range of matching colours. When adding, click “append” to make 
sure that the colours you already had remain. 

You can also easily create your own colour palette on handy sites 
such as https://color.adobe.com/create. For the people who are 
not experienced with colour theory (just look it up once you are 
bored some day), this website will find a colour scheme for you 
based on the colours you want. You can then immediately save your 
pallet and upload it to your Photoshop via the menu of those 4 
horizontal stripes.

You can also generate a colour palette based on an image. Just look 
what a magical pallet we can make with our 
minion. Brilliant.

Just as there are “swatches” for colours, they 
also exist for layer styles. If you go to “Window” 
-> “Styles”, you will already see a few. Add your 
own favourites to this as you are used to with 
the colours. Do play around with it!

Just like fonts, colours are very important to 
make your design beautiful and coherent. 
Strong combinations make your design more 
attractive than ever! You can even pimp your 
boring excel charts for your reports by picking 
out some cooler colours.

Shapes
Between the text tool and the colors you will find another rectangle at the bottom: this is one of your 
shape tools. Before we start popping rectangles on the canvas, I first want to explain a very impor-
tant contrast.

In the bar of the shape tool you will see the first setting “Shape”. There is a big difference between 
shapes and what we have been doing so far: adjusting pixels. Shapes consist of vectors: clever math-
ematical objects that keep their beautiful shape regardless of how much you zoom in or out. If you 
do the same with a photo (a set of pixels actually), it will become grainy, for example.

It is up to you to decide whether you prefer to work with pixels or with shapes. For example, a font is 
always a shape by default: even if you make it larger, you will rarely see pixelated edges where they 
are not small. However, if you want to adjust a layer of text as if it were pixels, you have to convert 
the layer to pixels. You do this by right-clicking on the layer and clicking “rasterize layer”. Going from 
pixels to shape is not that easy; you probably need Adobe Illustrator for that.

That rasterizing is familiar, isn’t it? I hoped so. We did that in the beginning with our minion image! 
In principle that was not a shape, but something else: it was an external file. What we were doing 
was dragging an image to Photoshop and adjusting it. However, we cannot adjust the image if it 
is not a Photoshop file or layer; it was an imported reference from Photoshop to the image in the 
workshop folder. However, we wanted to be able to draw on the minion, so we quickly rasterized. 
Well. The more you know.

The nice thing about shapes is that it always creates a new 
layer. Then you do not have to pay attention to whether 
you accidentally draw a rectangle on the wrong layer. The 
great thing about pixels is that you work with pixels, and 
you can apply all the operations you have learned so far to 
the rectangle. 
When you draw a shape, you will see that this menu will 
beep right above the layers:

At the top is the location and the size of the rectangle. 
Below that the colour, the colour of the border (currently 
empty, characterized by the white with the red stripe), the 
thickness of the border (which would be 1 px (pixel) if the 
border had a colour), and the type of border. The settings 
below it are quite visual, so go play with that. Then you can 
move your shape object freely over your canvas, and put 
the layer that contains the shape in a folder of your choice.

If you are working with pixels, you do not have all these settings. A good compromise would howev-
er be to first create a rectangle as a shape, then get all the shape settings in order, and then convert 
it to pixels. Then you can then do all your other edits that you had in mind, that wouldn’t work on a 
shape. If you don’t necessarily have that in mind, I recommend leaving the object a shape. This way 
you throw away as little information as possible!

By the way, it is again the case that if you draw your shape with the SHIFT key pressed, you will get a 
square or a circle, instead of a rectangle or oval respectively.

Fun tools
For the remaining part of part A, I have selected some nice tools that you can play with. Unique, and 
applicable in many more scenarios than you might think.

Clone stamp
Sometimes it is the case that there is an unwanted object on your photo, but that you only find out 
after the photo shoot. Think, for example, of a bottle of drink in the background or someone walking 
into your photo.

Just open the photo of the mysterious parking lot in Photoshop. Then grab the clone stamp 
tool from your toolbox using the shortcut ‘S’, or by clicking on this icon on the left:  

The clone stamp tool is like a brush, but instead of drawing with a specific colour or texture, you 
draw with pixels that are elsewhere in the photo. This way you can easily take over an existing tex-
ture without necessarily having to copy it. This is extremely useful for very uneven surfaces such as 
the skin, or actually pretty much everything in nature. 

You still have to tell Photoshop which pixels you want to paint with exactly. You do this by clicking 
ALT on the location of your source. I briefly made an overview of 
which pixels we are going to steal from where.

We are going to erase the mysterious gentleman plus full shad-
ow, so that we are left with just a boring parking space. For ex-
ample, in red you can see that the pixels that need to be in place 
of his head, so probably best come from a little further to the 
top right. There the grey has about the same shade. The inter-
secting lines that the gentleman blocks can probably best come 
from the top left as indicated by dark blue, etc.
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Just click ALT on the middle of the intersection that is indicated with dark blue. Now if you move 
your mouse, you will see that your brush shows which pixels it intends to draw. The trick now is 
to place the brush above the other intersection as carefully as possible, so that the lines continue. 
Before you start drawing, make sure your clone stamp has the hardness of the brush set to 0%. That 
makes for the smoothest transition, making it even less noticea-
ble.

Good. Once you have aimed where the other intersection can go, 
you can continue drawing. When you start drawing you will see 
that the source of your clone stamp moves relatively with where 
you draw. You should get something like this: 

My suspicion was therefore correct. We do indeed need a few 
more pixels from the adjacent parking lots to make that light 
spot blend in with the environment a bit better, but at least the person is already gone.

After pushing and drawing ALT for a few minutes, you will get something like this:

To a trained eye, this looks a bit blurry, but to 
95% of the population, this is just a photo of a 
parking lot with a lot of grit. That’s what we’re 
going for.

Photoshop is often about fooling the audience 
that what you have made is reality: the more 
real the better. The goal is therefore to make 
increasingly real pictures. This is already a good 
start, and the more often (and longer) you work 
with it, the more real it becomes. Don’t worry if 
your not photo isn’t real enough, most people 
won’t even notice. 

Content aware fill
Getting the clone stamp tool out of your pocket 
every time is quite a hassle. As you have noticed, 
that can be quite a bit of work to accurately pol-
ish everything away. We prefer a lazy solution.
Just open the picture of the falling gentleman 
in Photoshop. If you select the person with your 
favourite selection tool (even the square works 
in this particular case), you can then right-click 
on the selection and click the “fill” button.

If you set the contents to “Content-aware” in the 
fill settings, and then click OK, Photoshop will 
use the pixels around the selection to calculate 
how the photo would look without the selected 
object. After a few seconds of calculating you 
will see that the result looks quite accurate! Now 
it is not very exciting, but this tool is very versa-
tile and very easy to apply.

Unfortunately, the content aware fill doesn’t 
work on everything, so you still need to bring 
out the clone stamp every now and then to get 

everything seamless. For example, if you use this tool on the mysterious parking lot photo, you will 
see that Photoshop has a lot of trouble with the stripes.

Spot healing brush tool
Then one last tool to obtain something similar: the spot healing brush. With this tool you can, as it 
were, draw which pixels you want to have “filled” content-aware.

Just open the picture of the cows. Then select this tool. 

Make sure your brush is about 2x as wide as the size of the barbed wire, so you can draw a bit slop-
pier.

Then draw a line across the barbed wire. For example, start right in the grass. You will see that the 
barbed wire disappears, and Photoshop again calculates what should have been there. If you then 
calmly draw away all the barbed wire, you will end up with something like this:

That already looks a lot more animal friendly. You can of course polish up some small details with 
your clone stamp! 

Final tips
I have three more tips with which I wish to make your life easier again.
The first tip is to use rulers. A ruler is very useful for nicely aligning elements with respect to each 
other. You turn on rulers by pressing CTRL + R, or under “View” -> Rulers. Then:
1. Place your mouse on the rulers on the side that have just been added
2. Click and hold your mouse
3. You drag the ruler to the desired place on your canvas

Some extra tips on this: if you take a ruler from your left side, it 
will be vertical, while those from the top will be horizontal. It may 
not feel that intuitive, but it gets used to it. In addition: if you 
have selected an object, you can perfectly align the rulers to the 
centre and the edges of the object. Ideal!

You can also align objects by selecting the specific objects and 
selecting your move tool. Then there are all kinds of handy but-
tons at the top to align the objects as desired. The icons should 
speak for themselves; but do play around with it so you know 
what does what. 
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Lastly, I wanted to talk about exporting. In Photoshop, you can export images by using “Save as”, 
and picking a proper file-name and file-type after. I recommend using PNGs, this way the transpar-
ency of pixels is also saved.

Assignments 
That was the basis! That went pretty well, right? You can actually already do a lot more than you 
think. To put your skills to the test so far, I will give you one last set of assignments to conclude part 
A. It is up to you, using the images in the attachment, to recreate the images below as realistically as 
possible.

It can be quite a puzzle to apply everything you have just learned. If it doesn’t work, you can of 
course always ask questions during the workshop. After that, you unfortunately have to sort through 
the Photoshop toolbox yourself.

I will not be the worst in the A section; I’ll include a cryptic user guide that will hopefully give you 
a feel for how to tackle the problem. There are of course many more roads to Rome: as long as the 
result looks roughly as indicated, I will give you a 10. That’s what we’re all here for, right?

Caesar Bert
Rough steps:
1. Cut out Berts face
2. Paste it on top of August in the right angle
3. Think of a smart way to make Bert’s head more grey

Dirk Kuyt at the Spinoza Fire
Rough steps:
1. Cut out Dirk
2. Paste him on the Spinoza picture
3. Make sure Dirk’s arm points to the fire
4. Finish his finger using the clone tool (or steal a finger from Google)

You’re the star now
Rough steps:
1. Get rid of the original sign
2. Add text
3. Apply blending options to the text
4. Add construction bars
5. Make sure they blend into the mountain
6. Add some shadow

Closing Part A
Well done! Hopefully you have more faith in your Photoshop skills.

This was part A. I hope you learned a lot! May you not have ran home yet whilst crying, you can con-
tinue to part B. 

See you there!

Jorrit
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Part B
Welcome, Radboud Photoshop Elite, to Part B of the workshop. As promised, we are going to talk 
extensively about the following topics:

• More about layers
• Filters
• More about text
• More about brushes

I am assuming that you have already mastered quite a few things and know how all the previous 
themes work, so I will also include a little less screenshots in this section. If something is not clear, 
you know what to do: raise your hand while you are still at the workshop or, of course, consult your 
favourite search engine.

In addition, I added slightly less direct assignments. Then you can practice on the examples that ap-
ply to you! Do so, I would say, then you learn the fastest, and you kill two birds with one stone.

More about layers
What you now know about layers is just the beginning. Just open that nice car picture in Photoshop. 
We’re going to have fun with this in the next subsections. 

Masks
The first thing we will deal with are layer masks. After 
all, if you want to cut out an object, for example, we 
would previously just throw away the surrounding pix-
els. That is actually quite a shame; what if we find out 
later that we have thrown away a little bit too much? 
How do we get back to it?

With masks you never throw away pixels, but you 
simply whisper to Photoshop which pixels of a certain 
layer should and should not be visible. Click on the 
icon at the bottom of the layer screen which is circled 
with blue here, while you have selected the layer with 
the photo. You will see that, just like on my screen, 
there will be a white right next to it, with a chain in be-
tween. That chain symbolizes the relationship between 
the photo and the white layer: everything that is white 
on the white layer is visible in the car photo. Anything 
black is invisible. If you click with SHIFT on the white 
layer, you will see that you can turn it off and on. This 
white layer is your mask.

If you take your brush and put it on black, you can start drawing on your mask. Make sure you 
clicked the mask instead of the layer. If you paint, you will see that the pixels that you draw black 
disappear. You can also work with the selection tool, select the car, and draw the rest all black.

If you do it a bit neatly, you will get about this result (see next page). I strongly recommend that 
you always only work with masks instead of simply throwing away your selection. It may take a little 

more space on your PC, but it’s better to 
be safe than sorry.

Overlaying
Then we have overlays. An overlay is 
actually a bit of a lazy mask. Just create 
a new shape that you put under the car, 
so that they overlap a bit. Below is an 
example of what I mean. 

Then right-click in the layer menu 
between the two layers, while holding 
down ALT. If you hold your mouse over 
the spot of the red cross on the image, 
you should be fine. You will see that the 
car is only visible where the bar is visi-
ble. If you move the bar around, you can 
choose more specifically which part of 
the car is visible.

Of course this is an incredibly nonsensical exam-
ple, but hopefully you can imagine in what kind 
of situations this is useful. You can also turn it 
around so that the bar is only visible on the car. 
I mainly use this to add textures to objects. We 
will do this in the following example. 

By clicking again in the same place with ALT pressed, you separate the layers from each other again.

Blending modes
Layers have different blending modes. Depending on the blending mode, the pixels on that layer re-
spond to an operation or to other pixels in a certain way. Sounds very abstract, it is. It’s a lot of math 
applied on colours actually. I can’t make more sense of it. You don’t have to understand much about 
it, as long as you know it exists and when you would use it. We are now going to apply a number of 
them, so hopefully it makes a lot more sense by then. 
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You will find them above your layers, where it 
now says “Normal”. Just add the colour grid 
image that is in the workshop folder to the file, 
and put it over the car. Then try out each blend-
ing mode for a moment and observe what you 
see.

You can see that, for example, with “screen” the 
colors, as it were, make the car a bit lighter and 
also involve the colors of the grid a little.
In contrast, subtract uses the two overlapping 
colours to calculate and represent the differ-
ence.

For colour theory enthusiasts, this is a pretty in-
teresting topic, but if you don’t like it (probably the vast majority of you), it’s not that exciting. There-
fore, if you want to know more about it: feel free to contact Google.

Throw that colour grid back in the trash. What we are going to do 
now is indeed apply a texture. Place the texture over the car, let it 
overlay (see previous section) on the car, and apply the blending 
mode darken. If you set the layer to 15% transparency, you will see 
that it gives the car a subtle texture. I quickly removed the texture on 
the roof and windows of the car with a layer mask, and it now looks 
like the car on the right. 

Shortly said: “Darken” in this case removes all white pixels, leaving only the dark ones to place over 
the car. You can do an opposite operation with “screen”: this removes all dark pixels and leaves only 
the light ones.

On the internet you will find numerous textures and stuff like lens flares, but often these still have a 
white or black background. To save a lot of headaches, you can easily apply the blending modes.

This theme is pretty heavy, so we’ll continue quickly.

Layer adjustments
You have probably already seen Layer adjustments on your screen. Those are the buttons I displayed 
in the bottom right. These are layers that apply to all (!) underlying layers, and say something about 
how the pixels should behave. This could be that it all needs to be a lot darker or lighter, but also 
that certain shades can be a bit brighter than others.

You can use overlays to ensure that an adjustment only ap-
plies to a specific layer. Layer adjustments also make use of 
layer masks: super useful. 

Just click on that effect on the far left in the middle row. Then 
the sun at the top left. Play with the settings and try to copy 
the example.
What this does is again something cool with colours. The col-
our spectrum shifts in a certain way, making the car suddenly 
look pink. I kept the roof white. I also made everything a bit 
lighter.
This effect applies to many examples. You can change the 
colour of someone’s eyes with this, someone’s sweater, and so 
on. 

Smart objects
Smart objects are, as it were, small Photoshop files in a larger Photoshop file. You can select multiple 
layers at the same time on the right, then hit “convert to smart object” in the right mouse button 
menu to create one.
They are sort of a group of layers, but then there are some nice extras to it. We will explore those in 
a minute. You can double-click on the image of the layer in the layers menu, or click “edit contents” 
in the right mouse button menu to edit it again.

In the same menu you can also export your smart object as a separate file, so that you can also apply 
it in other files. This way you can have quite complex returning motifs without too much effort. Im-
agine the possibilities!

You can always convert a smart object back to pixels by rasterizing it. Then you will, however, lose all 
information, and it will become raw pixels again.

Locking aspects
A last feature that I would like to mention about layers is the fact that you can also lock them. It is 
sometimes very annoying to accidentally move an object, for example. The following freeze options 
exist:
• Freeze all transparent pixels
• Freeze all non-transparent pixels
• Fix the position
• Fixing something that we will not use in this workshop
• Fix everything at once
Pinning means that you can no longer adjust what you pinned until you click that same button 
again. This is very useful for backgrounds, for example. These locking options can be found above 
the layers in the layer menu.

Filters
In Photoshop there are countless filters with which you can pimp your work of art even more. You 
can find them in the heading “Filters”, which is at the very top of the bar of “File, Edit,…. , Filters “. I’m 
only going to discuss a few, but it’s really helpful to know it exists and how to apply it most effective-
ly.
If the filters I discuss below or those you can find are not what you’re looking for: you can always 
download extra filters on the internet or even create your own. You can look up the latter yourself; 
that’s for the real Photoshop bosses.

Smart filters
As promised in the smart objects section, I will explain how you can easily add effects.

Normally, effects are destructive: that means that they overwrite the layer and all information on it 
when you apply the effect. However, if you have created a smart object, you can also apply “smart 
filters” to it. These are filters that remember what their editing entails, but only perform them vis-
ually, as it were. Your smart object remains unaffected. You can then turn the effects on and off, and 
adjust all their settings. That is not the case if you work with regular layers.

I highly recommend converting any layer you are going to play with using effects to a smart object.

Blur
One of the best-known effects is the blur. Blur can be suitable for all kinds of moments; you can give 
an object visual speed, as it were, by throwing a motion blur on it, but you can also draw attention to 
a particular object by blurring its surroundings. 

For example, apply some motion blur to the car that we have in a smart object. If you do it subtly 
enough, it will look like the car is torn on it at a lot of speed. A nice extra is that it matters a lot less 
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how beautiful your selection is: all edges are 
faded anyway. You can see an example on the 
right.
You can even adjust the mask of the smart 
filter, and add a blending mode and transpar-
ency for each effect. 

Browse through the different effects and try 
to formulate what you see for yourself. A few 
favourites of mine: “Stylize -> Tiles”, “Pixelate -> Crystallize” and “Stylize -> Extrude”.

Liquify
A final filter that is both very nice and useful is the face liquify. Just take out the Putin image and 
apply “Filters -> Liquify”. You will see a lot of settings on the right; you will probably have to expand 
Face-aware liquify.

What you can do next is 
change a lot of face settings. 
You can drag a few things 
on the image itself, or do 
this on the right using the 
sliders. I made Putin laugh a 
little more and made his face 
a little slimmer; can you do 
that too?

This feature can genuinely 
come in handy to make your 
group photo a little more 
fun, or that one photo in 
your brochure just a little more cheerful. I assume that you do not want to put your product up for 
sale with silly photos. Or yes, depends on the product. Good. You understand me.

Face-aware liquify is only a small part of the liquify tool: play around with all the 
tools you can find. Tip: on the left are a few more tools with which you can do a few 
things. If you like memes, this is your new territory. Just look at what kind of awful 
picture I have put together with this... Please don’t tell Putin.

More about text
For the next part you need a new menu. Go to “Window -> Character”. You will see 
that Photoshop shows you the Character menu, together with the Paragraph menu.

As said before, text can be very important to your image. In this section, I’m going to explain how 
you can take your typography game to a new level. I will be referring to the picture in the top left on 
the next page.

At the top you see your Font-Family (Comic Sans MS) and your Font-style (Italic). Below that, in blue, 
you can see your Font size (12pt), the line spacing (Auto (automatic)), and below that two options for 
how the characters are next to each other. 

The left option indicates whether the letters just use their original space, or whether they are folded 
a bit more so that it is optically more interesting. To the right of that, you can say how much space 
comes after a certain character.

You can apply the settings to a selection of text, 
or to all text. You can quickly select all the text by 
hitting CTRL + A, as you may remember from the 
intro to Part A.

Below you will find some less common settings: 
between the red and blue square you can set how 
high each letter is, how wide, and whether you want 
to move it vertically. Then you can also adjust the 
colour here.

Below that you will find all kinds of other options in 
red, such as fake bold, fake italic, full-caps, under-
line, etc. It goes without saying. At the very bottom 
you can see some more artistic options. Above 
all, try it all out. Just type some nonsense on your 
screen and start dragging. Make it a work of art 
with layer styles, blending modes, overlays, etc. I’m 
very excited to see what you’re making.

In the “Paragraph” menu that you got with it, you can also choose whether your text aligns from the 
left, middle, or right. This menu only gets really exciting if you don’t just have text, but work in a text 
box. You do by drawing a rectangle with the text tool. At the top you can choose how the text aligns 
with respect to the box, and on the right you can choose how much space to leave between para-
graphs, or how much to indent text.

If you think this is a useful menu, I recommend you take a look at InDesign. That will be some kind of 
heaven for you!

More about brushes  
There is much more to discover in the world of brushes. This way you can add a lot of variation and 
refinement to your brush, which will only benefit your work.

This way you can give all your brush a certain transparency in advance; if you then draw twice on a 
certain area, it will become less transparent. 

You can also work with ‘flow’: it used to be at 
100. For example, if you hit it at 20%, the edges 
will become a bit smoother and you will also 
see that if you colour over a certain area more 
often (this time it can be in the same operation, 
by just adjusting opacity you have to redraw 
several times), that it then becomes darker. Flow 
therefore provides more vibrancy and realism in 
your image.

Customize brushes
Go to “Window -> Brush”. Suddenly all brush 
settings appear on your screen. Here’s a screen-
shot. 

On the screen you will see all brushes that you 
have, displayed together on the right side of the 
screen. Then you will find a lot of extra settings 
on the left, circled with blue. With these settings 
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you can adjust how the brush behaves; with this 
you can do quite interesting edits with a simple 
form. Then you can see at the bottom, circled 
with red, how the brush behaves if you were to 
use it.

Take a look through the options on the left, and 
make another nice piece of art like you did be-
fore. Here on the right you see something I once 
made with brushes and some cool layer styles; it 
doesn’t have to be an ugly minion landscape. 

By the way, if you have found the golden com-
bination of settings, you can save the brush with 
the button at the top right. Useful, don’t forget!

If the current brushes are not quite it for you, 
you can always add new brushes. You can simply 
download it from the well-known internet or 
make it yourself. The latter can be done quite 
easily by grabbing a square image, and then clicking “Define Brush Preset” at “Edit”. This makes a 
brush in the shape you specified. Any colours will be converted to shades of grey, so I recommend 
that you work with that in advance so that you will not be faced with surprises.

Short intermezzo: you can also click “Define Pattern” under “Edit”. This will cause you to create a pat-
tern from any piece of image you have. Very handy, you can add this as a layer effect to your objects; 
or the layer on which you start working with your brush. Extra cool.

Drawing light
If you overlay a layer on another layer, for exam-
ple the car, and give that new layer the blending 
mode “Luminosity”, you can redefine the light 
incidence with all kinds of grey tones. The layer 
below will take over your shades. If you take a 
very soft round brush, you can carefully colour 
over the edges of the car.

To illustrate, I have just demonstrated it with the 
car. Perhaps a bit extreme, but then you will see 
the difference.

By the way, the light does not necessarily have to be a shade of grey; it can also be red or yellow. 
Then you have to choose a different blending mode.

Play around with the opacity for an optimal result.

Clone stamp settings
Lastly; we talked about the clone stamp tool earlier this workshop. In order not to make it too com-
plicated at the time, I have not yet told about the “clone source” menu. Just open it via “Window -> 
Clone Source”.

For example, you can store multiple clone sources here, instead of always throwing away your cur-
rent one for a new one. You can also rotate your source, mirror it, and a few other nice things. Do not 
forget this window! You can also use multiple shapes brushes for clone stamping, should that ever 
be useful.

Final assignment
Not bad. You now belong to the absolute Photoshop Elite of the Radboud. Looks like you have mas-
tered it quite well. Prove that to yourself again by performing the following tasks, then you will be a 
free elf.

Face swap
I made my example a long time ago during my first Photoshop workshop; Jorrit Geels on the head of 
Bob Ross. It’s acceptable... The rough steps:
1. Choose your two targets
2. Cut out target A’s face
3. Stick it on target B’s face so that the eyes match
4. Erase the edges with a soft eraser
5. Apply layer adjustments until the skin color matches
6. Use the brush to match the light

Poster
Make a poster for an event of your study association! Make it as eye-catching and visually appealing 
as possible. Below you see, for example, a BeestFeest poster that I once made. With a simple back-
ground, some text and a good dose of overlays and textures you will quickly stylize your poster.

The tree on the right was actually a mirrored version of the tree on the left, but with the clone stamp 
tool it was made a bit more unique.

Album Cover
Create an alternative album cover for your favorite artists! This is my attempt to surpass the cover art 
of Kanye West’s “The Life Of Pablo”. Now it’s your turn!

Use text, images, cool blending modes, filters and layer styles to create cover art that you say “you” 
to.
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Final words
That’s it for now. Well done. You now have all the tricks up your sleeve to make the best graphical 
edits of Nijmegen and surroundings. The only limit is your creativity. 

May you forget something, you can always look it up online: Photoshop is a very common piece of 
software and an active forum where users ask and answer questions. Next to that, there are many 
people that like explaining Photoshop just like me, so don’t hesitate to look up some tutorials / 
workshops online.

Lastly, I can only say that you will learn it by putting in the hours. At some point, making a textbox 
is more of a routine thing than something you think through. Your first design will definitely not be 
your best, but you can always edit it later on. Being open for mistakes and learning from them is the 
best quality of a great Photoshopper. Also for life by the way. Deep stuff.

I might have already said it too much, but I truly hope you enjoyed this workshop and that you 
learned a lot. Me too! I hope some of you will be sparked with inspiration and perhaps make there 
presentations and projects in Photoshop from now on. Or maybe even the minutes of your commit-
tee. Please don’t. 

To end off on a happy note (that’s a Dutch saying at least), here you have an applicable meme. It’s 
one of those super old 9GAG-format memes which I normally hate, however I found it the best way 
to end this workshop. I’ll let it slide.

Enjoy.

Jorrit


